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AnalysisPlace 
Excel-to-Word Document Automation Add-In
Update/create Word and PowerPoint content (text, tables, and charts) based on Excel data and calculations.

[image: ]

Sample Content and How-To Guide

This document demonstrates key capabilities of the add-in. Use it with AnalysisPlace_Sample_Content_and_How-To_Guide.xlsx
Also see the Example Financial Tables


To use this document:  

In Excel:
· Add the add-in (Excel Ribbon Menu: Insert > Get Add-ins), then activate it (right side of Home ribbon)
· “Insert Sample Content” on the Start tab of the add-in
· Make changes to any of the tan input cells in the workbook. Start with the QuickStart worksheet 
· “Submit Content” in the Excel add-in
Here In Word:
· If the add-in is not visible, add/activate it
· “Update Document”, in the add-in in this document. You should be able to see the changes starting on the next page based on your Excel modifications

[bookmark: _Text,_Bullet_Lists,]If you are not already familiar with the basic features of the add-in, first see AnalysisPlace.com

This document has “Auto-Open” enabled, meaning the add-in should automatically open with the document. Normally Auto-Open can only be enabled with Excel workbooks.
[bookmark: _Toc123730832]

QuickStart Sample Content
See Excel Worksheet: QuickStart
The “dynamic” content in this section will be updated based on the data submitted from Excel when you click “Update Document” in the Update tab.
Example Text
The text below is updated based on the Excel “r_TextSummary” range under the “Summary” heading:
MyCustomer can realize $125,594 in benefits with an investment of only $25,324 -- that is an ROI of 396%.
Text links can also appear mixed in with other text: MyCustomer is the customer name (it’s source is “r_CustomerName”).

Example Tables
Destination Table
The table below is updated based on the “r_ROISumTable” range in Excel. It is a Destination-formatted table, so only the text/values will be updated – the format is set here in Word and won’t be modified by the update.
	One Time	Annual	Total
Costs	$9,550	$3,155	$25,324
Benefits	$0	$25,119	$125,594
Net Benefits			$100,270


Flex Table
The Flex Table below is based on the “r_ROISumTableFlex” range. It is Excel-formatted, so any changes in Excel (format or values) will be shown below after the update.
​	Income Statement ($Millions)
​	2022	2021	Change
Gross Sales	$10,000	$9,500	5.3%
Returns	$513	$487	5.3%
Net Sales	$9,487	$9,013	5.3%
Cost of Goods Sold	$2,436	$2,314	5.3%
Operating Expenses	$3,942	$3,745	5.3%
Operating Profit	$3,109	$2,954	5.3%
Interest and Other Income	$385	$365	5.3%
Tax Expense	$513	$487	5.3%
Net Profit	$2,981	$2,832	5.3%



Example Charts
This chart is updated based on the Excel table named “r_LineChart”:


This chart (a png image) is updated based on the Excel chart named “r_CostsVsBenefitsChart”:


Example Shape
This image is based on the shape named “r_ScrollShape”






Table of Contents
	Section
	Worksheets (Data Source)
	Description

	Text, Lists, and Paragraphs
	Text & Lists
	Excel-sourced text can be incorporated into documents in a variety of ways. This section shows how to: 
· Add text to various document content types (titles, paragraphs, shapes, etc.)
· Incorporate/update data within text
· Dynamically create lists and paragraphs (based on Excel formulas)

	Tables
	Tables
	The add-in was designed to support a variety of table updating scenarios. This section describes/demos key table features:
· Source Excel data can be based on named ranges or tables (data tables)
· Table formatting set in Word/PowerPoint will not be modified after the update
· Supports tables with merged cells
· Tables automatically resize to match source (Excel) table size
· Tables can be configured to hide rows if hidden in Excel

	Image of Ranges
	Range Image
	Transfers the image of the named range, just as it appears in Excel. The range can include SparkLines, product images, Maps, SmartArt, people photos, and Conditional Formatting in cells.

	Charts
	Charts
	Updates charts based on data in an Excel range or table. Can update many large charts rapidly.

	Chart Images
	Chart Images
	Essentially any chart type is supported and charts can contain a variety of added content (text, images, etc.)

	PivotTables
	Pivot
	Excel PivotTables can update PowerPoint tables or can be transferred as an image

	Shapes/Images
	Shapes
	Transfer any type of shape: text boxes, lines, geometric shapes, SmartArt, WordArt, pictures/photos, icons, maps, and equations. Shapes can contain dynamic content.

	HTML
	HTML
	Enables inserting HTML content into Word. Format text (bold, colors), add hyperlinks, insert images from URLs, etc. HTML can be created dynamically.

	Layout Options
	Misc
	Dynamic content can be incorporated in a variety of ways (not just in-line), enabling great-looking documents/presentations.
Content can also be updated in headers and footers (Word) and in PowerPoint master slides

	Conditional Sections (Document Assembly)
	Conditional Content
	Describes how the add-in can include/exclude document sections, similar to "Document Assembly". Conditional Content automatically removes un-needed Word sections or PowerPoint slides.

	Auto-Hide Rows/Columns
	Auto-Hide
	Automatically hides/unhides rows/columns based on cell value/formula when you click the "Auto-Hide Rows/Columns" button.

	Mail Merge
	Mail Merge
	Shows how to quickly update multiple documents (one at a time) based on a table or database of information. Typically each row/record would contain data to update each document.

	Localization – Currency
	Currency
	Shows how to change currency symbols and exchange rates in your Excel and destination documents 

	Localization - Language
	Language
	Shows how to switch languages. 

	Import Data (getting data into Excel)
	Misc
	Users commonly import data from external sources into Excel, so it can then be analyzed and updated in Word and PowerPoint documents. Common data sources include: web site data; databases; Azure; CRM/ERP systems, such as Salesforce; other Excel workbooks, web services, XML/JSON data, etc. 


[bookmark: _Text,_Bullet_Lists,_1][bookmark: _Toc531342346][bookmark: _Toc123730834][bookmark: _Toc531342344]Text, Bullet Lists, and Paragraphs
See Excel Worksheet: Text
Excel-sourced text can be incorporated into documents in a variety of ways. 
Single-cell named ranges update text items (e.g. titles, paragraphs, parts of text, lists) in Word/PowerPoint.
All linked content in Word is included in Content Controls. You can hide the Content Controls (e.g. prior to sending to customers) by selecting “Hide” at the bottom of the “Link” tab in the add-in.
Add Text to Various Document Content Types
Linked text can include or can be within: paragraphs, titles, text boxes, most shapes, WordArt, headers/footers, or a table cell. You can style the text as desired (colors, bold, font, etc.) and the style will remain after the update. 
 This example shows the linked text within a shape:
Customer XYZ

Combining Text and Data 
Data can easily be combined with text using the text() formula in Excel:
Customer XYZ will save $900,000.
Lists and Paragraphs
The add-in can create lists that change based on formulas in Excel. List are based formulas in a single cell.
· Lists from Excel (a single link/control) can be styled as bullets or numbered lists. 
· Alt-enter is typically used for manually created lists.
· Char(10) is used if you want to list to change dynamically (part of a formula).
· In cloud-created reports (PowerPoint or template-based Word reports), you can add multiple levels (indents) to your bullet lists by adding a greater-than symbol ">" to the start of the line in Excel. Add 2 ">>" for level 2 or  ">>>" for level 3 indents. These can be added dynamically to formulas.
This example shows a dynamically created (based on an Excel formula) bullet list:
A. Project Summary
Customer XYZ will save $900,000.
Payment must be received by May 18, 2025.
Customer will be happy.
In this example, the items are an automatically numbered list:
B. Project Scope

Basic Features
Management Module
Implementation Services
Maintenance
Support Services
This example shows dynamically created (Excel-sourced) paragraphs:
Legal Details
Lorem ipsum dolor sit amet, ei cum apeirian voluptaria. Lorem debitis liberavisse ex cum, fugit consulatu consequuntur eam eu. Te sea oratio utinam qualisque, inani numquam eruditi quo ei. Choro fierent cu eos, ex omnis eruditi nec. Graece consetetur consectetuer qui an.
Ut ludus omittam mea, eu has harum cotidieque, te per libris minimum rationibus. Dolore vituperata honestatis vim ei, erat decore blandit ea usu. Vero invenire eos ne, duo ea oporteat scribentur, essent volutpat eum ei. Ex eos ceteros invenire, timeam omnesque constituam ut mea. Cum integre epicurei comprehensam et, an cum iudico nominati interesset. Cu nam sanctus laoreet, ad ignota tibique tacimates eum.
Quas nonumes fuisset te pro, mei ad dolores vivendum, vim ei tantas dolorem. Id mentitum qualisque sit. Id mel quot delectus. Tibique perpetua vix te, vim assum senserit cu. At his quis sumo simul, apeirian forensibus eam ut. At sale repudiandae mel, vis cu ullum placerat iracundia. In vis quis labores apeirian, liber tempor qui cu, sea ut graeci instructior consectetuer.
Ex ius posse vivendo. Ea per quod scripta. Lucilius lobortis ei quo, ei zril maiestatis percipitur vel. Iudico suscipit sit te, patrioque deseruisse mnesarchum pri no, sea cu movet labitur accusam. Est homero apeirian concludaturque et.
[bookmark: _Image_of_Ranges][bookmark: _Tables][bookmark: _Toc123730835][bookmark: _Toc531342345]

Tables
See Excel Worksheet: Tables
Overview
The add-in was designed to update Word/PowerPoint tables for a variety of scenarios, including updating of large/complex tables, such as financial reports. 
The add-in allows you to update Word and PowerPoint tables in 3 ways: 1. Destination-formatted tables, 2. Excel-formatted (Flex) tables, and 3. Via an image of the source range/table.
See the “Tables” tab in the workbook for a detailed comparison

See Excel Worksheet: Tables
This table will update based on changes made to the range name: r_TableComparison
	Column 1	Column 2
Row 1	5/18/2025 23:34	Red
Row 2	$2.00	Verdana Pro Font


[bookmark: _Toc123730836]Destination-Formatted Tables
Formatting is applied in the destination (Word or PowerPoint) -- the update does not modify the table format, only the text/values
See Excel Worksheet: Dest
Named Ranges Vs. Data Tables
Source Excel data can be based on named ranges or tables (data tables). They both can update Word/PowerPoint tables the same way. The first and third tables below are based on named ranges; the second is based on an Excel table.
Create and Format Tables
In Word, you can link tables in 3 ways (first Add-in > Link > “Get Excel Source Data” > Select your table source from the drop-downs):
1. Insert a new table:  (Ribbon > Insert > Tables > Table); format the table (Ribbon > Table Tools > Design); select the entire table by clicking the icon above/left of the table; then link the table (Add-in > Link > “Insert Content / Update Link”).  
2. Link an existing table: select the entire table, then “Insert Content / Update Link“ button. The table should have the same number of rows/columns as the source Excel table/range.
3. Insert and Link: put the cursor where you’d like the table, then simply click the “Insert Content / Update Link“ button. 
You can style tables (Table Styles, borders, font, colors, etc.) and the style will remain after the update (only the text will update).
Automatic Table Resizing (Insert/Delete Rows/Columns)
The add-in will try to resize Word/PowerPoint tables to match the size of the source Excel table/range. For example, if the Excel table has 7 rows and the Word table has 4, the add-in will insert 3 rows. The next-to-the-last row/column will be used for the format template for the inserted rows/columns.
There are some limitations, for example, the Word add-in cannot insert/delete columns if there are merged cells in the table.
[bookmark: _Tables_–_Merged]

Table Merged Cells
The add-in supports most Word/PowerPoint table merged cell scenarios. The table below contains 2 merged cell areas in the 1st row.
 	 	Initial One-Time	Annual On-Going	
Description	Units	Qty	Cost Each	Total	Qty	Cost Each	Total	3-Year Total
Product A User Licenses	Licenses	95	$200 	$19,000 	95	$50 	$4,750 	$33,250 
Product A Server Licenses	Server CPUs	4	$4,000 	$16,000 	4	$1,000 	$4,000 	$28,000 
Implementation Services	Person-days	6	$1,600 	$9,600 	0	$1,600 	$0 	$9,600 
Training Services	Days	10	$2,000 	$20,000 	3	$2,000 	$6,000 	$38,000 
Support Services	Incidents	0		$0 	10	$1,000 	$10,000 	$30,000 
Total				$64,600 			$24,750 	$138,850 

If the add-in does not place content in the desired Word cell, try adding a space to the empty Excel cell to the left of the data that ends up misplaced.
[bookmark: _Disable_Specific_Table][bookmark: _Charts_/_Graphs][bookmark: _Toc531342350][bookmark: _Toc531342349]Hide Table Rows
To include visible rows/columns only: in Excel, set Item Property "Include hidden rows & columns" to 'No' or add the suffix "_visible" (or "_vis") before the range or table name. Hidden, filtered, or grouped rows will not appear in your Word/PowerPoint table. Can be combined with _body. 
The table below demonstrates this – it only includes visible rows in the source Excel table. The table is resized to match the Excel table visible row and column counts.
Merchant	Date	Category	Amount
The Phone Company	5/18/2025	Communications	$120.00
Best For You Organics Company	5/16/2025	Groceries	$27.00
Coho Vineyard	5/15/2025	Restaurant	$33.00
Bellows College	5/14/2025	Education	$350.00
Best For You Organics Company	5/12/2025	Groceries	$97.00




Simple Financial Statement Example
This example demonstrates that the destination content appearance can be very different from the source Excel format.
	5/18/2025	% of Revenue
Total Revenue	$800,000,000 	100%
Cost of Revenue	$440,000,000 	55%
Gross Profit	$360,000,000 	45%
Operating Expenses		
Research and Development	$104,000,000 	13%
Sales, General and Admin.	$160,000,000 	20%
Non-Recurring Items	$16,000,000 	2%
Other Operating Items	$8,000,000 	1%
Operating Income	$72,000,000 	9%
Add'l income/expense items	$8,000,000 	1%
Earnings Before Interest and Tax	$80,000,000 	10%
Interest Expense	$8,800,000 	1%
Earnings Before Tax	$71,200,000 	9%
Income Tax	$21,360,000 	3%
Net Income	$49,840,000 	6%


[bookmark: _Toc123730837]

Flex Tables (Excel-Formatted)
Flex Tables (including format) are created in Excel and replace the Word table during the update.
See Excel Worksheet: Flex
Also see the Example Financial Tables
Income Statement Example
Flex tables can update many large tables in a document
Income Statement	​	​
US$000	2025	2024
	current year	      prior year
Revenue	​	​
Gross sales	$10,000	$9,500
Less: sales returns	$385	$365
Less: Discounts and Allowances	$128	$122
Net Sales	$9,487	$9,013
​	​	​
Cost of Goods Sold	​	​
Goods manufactured: Raw materials	$1,026	$974
Goods manufactured: Direct Labor	$1,154	$1,096
Overhead	$256	$244
Total Cost of Goods Sold	$2,436	$2,314
Gross Profit (Loss)	$7,051	$6,699
​	​	​
Operating Expenses	​	​
Advertising	$1,282	$1,218
Delivery/Freight Expense	$64	$61
Depreciation	$13	$12
Insurance	$6	$6
Interest	$641	$609
Mileage	$128	$122
Office Supplies	$128	$122
Rent/Lease	$64	$61
Maintenance and Repairs	$192	$183
Travel	$128	$122
Utilities/Telephone Expenses	$1,026	$974
Wages	$256	$244
Other Expenses	$13	$12
Total Operating Expenses	$3,942	$3,745
Operating Profit (Loss)	$3,109	$2,954
Interest Income	$256	$244
Other Income	$128	$122
Profit (Loss) Before Taxes	$3,494	$3,319
Less: Tax Expense	$513	$487
Net Profit (Loss)	$2,981	$2,832




Table with Conditional Formatting
Supported Conditional Formatting formats: background color, font color, border color, bold, italics, and underline
Sales Region            	Quarter 1	Quarter 2	Quarter 3	Quarter 4	Growth
North	$4,500	$4,400	$4,900	$5,200	16%
South	$6,500	$6,400	$6,000	$5,900	-9%
East	$6,100	$6,000	$6,100	$6,200	2%
West	$5,000	$5,500	$6,500	$7,200	44%


Titles in Columns Example
Section 1	​
​	Section 1a	​
​	​	Content	data
​	​	Content	data
Section 2	​
​	Section 2a	​
​	​	Content	data
​	​	Content	data


HTML in Cells
Most HTML/CSS can be included in Flex table cells.
Formatted text (could be dynamic)	Text with Bold, Underlined, Red
Images (could select different images based on scenario/logic)	
Conditional Formatting, HyperLinks, lists, and many other possibilities	Ordered List:	Coffee	Tea	Milk	UnOrdered List:	Coffee	Tea	Milk	  




Image of Ranges
See Excel Worksheet: Image
This feature transfers the image (PNG) of the named range, just as it looks in Excel.
Name the cell or range of cells (starting with the prefix and ending with "_img"). Include any content in the range (conditional formatting, sparklines, images, shapes, text boxes, smart art, dynamic items, etc.) The image (PNG) of all content in the range will be transferred to your Word/Ppt document just the way it appears in Excel. 
Large images significantly increase transfer size and will make the Word/PowerPoint file much larger.
Image based on range containing a variety of formula-based elements
This example shows sparklines, conditional formatting, and a chart in a range. The source of the image below is a named range in Excel.

Border Issue Fix
Original png image (missing border):

Fix applied (paste as linked picture)

[bookmark: _Toc123730842]

Charts
See Excel Worksheet: Charts
The chart examples below have been linked to the table “r_CommonCharts”
    
    
The chart example below with date based items has been linked to the table “r_DateCharts”


 The Pie Chart examples below have been linked to the table “r_PieCharts”
    

The Scatter Chart examples below have been linked to the tables “r_Scatter” and “r_Scatter2Series”
    

The Stock Chart example below has been linked to the table “r_StockChart”
The Sunburst Chart below has been linked to the table “r_Sunburst”
    

The TreeMap Chart below has been linked to the table “r_TreeMap”


[bookmark: _Toc123730839]

Chart / Graph Images
See Excel Worksheet: Chart Img
When charts are submitted, the chart image (PNG) will be transferred to your Word/PowerPoint document. So format them in Excel the way you want them to look in your document.
You can use essentially any type of chart/graph.
Image Size, Quality, and Resolution
	You can change the image size and resolution.  Higher resolution charts appear sharper in Word/PPT, but also increase transfer size and Word/PowerPoint file size.
To Resize Chart Images: append your chart name with '_h' then the desired height in pixels or '_w' and the desired width in pixels. For example, 'r_Chart_w250' creates the image so it is 250 pixels wide (8.8 cm / 3.5 inches). The non-specified dimension scales so the aspect ratio remains the same.
In Word, you can constrain the image size by placing the image within a container, such as a text box or a table with the cell Auto-Fit set to "Fixed Column Width". If you don’t constrain it, by default, its size in Word/PowerPoint will be the same as its size in Excel. The image above is within a text box to control the image size.
	





Charts with Added Content
You can include other content to your charts, such as dynamic text, images, shapes, etc.
This feature can enable very powerful/flexible content automation capabilities.
The chart below contains formula-based text and an image which will update based on the growth rate:
[image: ]


[bookmark: _Hide_Table_Rows][bookmark: _Headers,_Footers,_and][bookmark: _Layout_Options][bookmark: _Toc531342355]


[bookmark: _PivotTables][bookmark: _Toc123730840]PivotTables
See Excel Worksheet: Pivot
Use Excel PivotTables for the source of tables (including images of tables)

Flex Table (Excel Formatted)
Category	2023	2024	2025	Grand Total
Accessories	​	67800	​	67800
Bikes	​	6300	​	6300
Clothing	23700	2300	40000	66000
Components	2300	4100	25700	32100
Grand Total	26000	80500	65700	172200


Destination-formatted PivotTable
Category	2023	2024	2025	Grand Total
Accessories		$67,800		$67,800
Bikes		$6,300		$6,300
Clothing	$23,700	$2,300	$40,000	$66,000
Components	$2,300	$4,100	$25,700	$32,100
Grand Total	$26,000	$80,500	$65,700	$172,200


Image of PivotTable




[bookmark: _Shape_Images][bookmark: _Toc123730841]Shape and Images
See Excel Worksheet: Shapes
Transfer any type of shape to your Word/PPT document: text boxes, lines, geometric shapes, SmartArt, WordArt, pictures/photos, icons, maps, and equations. Shapes can contain dynamic content (based on a formula or using automation such as VBA macros or other add-ins).
Shapes with Data rShapesWithData

rEquation


rPictureWithText

[bookmark: _Charts_(Native_Charts)]



[bookmark: _HTML_1][bookmark: _Toc123730843]Image updated based on user selection or cell formula
The example below displays a flag image based on a country that is selected based on a drop-down list in Excel. It shows an image which appears in a single cell in Excel. This technique is commonly used to display product images based on selected/configured solution or people photos.
Country Selected: Algeria

Image in a Cell (Paste Picture in Cell)
Allows you to use formulas/logic to submit/update different pictures based on a configured scenario
r_SelectedPicture_img

Image Function
The =image() function can also insert an image based on a URL. It is not shown here because it requires a security approval in Excel.

Depending on your needs, there are also many ways to use VBA macros (and other add-ins) to modify the image displayed in the cell (which can be updated in Word/PowerPoint). Images could also be based on a URL from a remote web site.
[bookmark: _Chart_/_Graph]

HTML
See Excel Worksheet: HTML
This feature enables extensive added formatting/content options, for example: 
· Format text via header tags, like <h1>
· Format content via the style= attribute. For example, change font size and color
· Insert images from a URL via the <img> tag
· Hyperlinks: <a> tag
· Lists: <ol><li> and <ul> tag
· Tables: <table> tag
· Emphasize text via the <b>, <strong>, <u>, <i>, and <em> tags
The HTML content in the source Excel cell can be created via formula or programmatically (VBA macros, other add-ins, or external applications).
The name of the Excel cell must end with “_html” to insert the content as html.
Some html content is not compatible: for example: </br>, css styling
Note: when creating reports via Word Cloud (Enterprise Feature), image will not appear until the the opens the document and clicks “Enable Editing”.
This example inserts text and a table with basic formatting:
HTML formatting examples: bold; red.
Table:
Month	Savings
January	$100
February	$125


This example inserts lists:
Ordered List:
Coffee
Tea
Milk
UnOrdered List:
Coffee
Tea
Milk
  
This example inserts an image (a fantastic company’s logo) with a hyperlink:
AnalysisPlace


This example dynamically (based on a user selection and Excel formulas) creates html with a title, an image, text, and a hyperlink:
Ferrari 250 GTO

The Ferrari 250 GTO is a GT car produced by Ferrari from 1962 to 1964 for homologation into the FIA's Group 3 Grand Touring Car category. It was powered by Ferrari's Tipo 168/62 Colombo V12 engine.
Learn More


[bookmark: _Conditional_Sections_(Document][bookmark: _Conditional_Content_(Document][bookmark: _Toc123730844][bookmark: _Toc531342354]Conditional Content (Document Assembly)
See Excel Worksheet: Conditional Content
AnalysisPlace can not perform "Document Assembly" per say, but it can do the equivalent: It can automatically delete un-needed sections from the template. So include all needed content in your Word or PowerPoint templates, then configure your workbook to automatically indicate (e.g. based on formulas) which sections to delete, depending on the user scenario.	
Common examples of “optional” content (which can be deleted based on the scenario):
· Industry-specific case studies:  case studies for all industries are included in the master Word/PowerPoint document, then all but the desired industry case study are deleted when the report is created/updated for a specific customer.
· Report (e.g. proposal) sections: all sections are included in the master document, then when the report is created/updated for a customer, unneeded sections are deleted.
In Excel, range names that start with “delete_” that contain value TRUE, determines which sections of created Word or PowerPoint reports will be deleted. Alternatively in Excel, use a "ReportSectionsToDelete" table.		
In Word, see the “Conditional Content” section on the “link” tab of the add-in. You can create and list sections there. Sections are defined by Content Controls. 
The sections can be nested. Sections can (and usually do) contain linked content.
Conditional sections are highlighted in yellow (if “Show All” or “Show on Hover” are selected).
The sections below demonstrate how this feature works. Sections will be deleted depending on the Secenario selected in the “Select a Scenario” input cell in Excel. In the template, there are/were 9 sections below:

SectionName
	Section content
CostAnalysis
	Section content
CaseStudyA
	Section content
CaseStudyB
	Section content
FinancialAnalysis
	Section content
AppendixA
	Section content
	
	
AppendixB
	Section content


[bookmark: _Mail_Merge_1][bookmark: _Auto-Hide_Rows/Columns][bookmark: _Toc123730845]Auto-Hide Rows/Columns
See Excel Worksheet: Auto-Hide
Automatically hides/unhides rows/columns based on cell value/formula when you click the "Auto-Hide Rows/Columns" button in the Excel add-in.
This example is a Flex table.
​	Column A	Column B	Column C	Column D	Column E	Column F
Row 1	r25c3	r25c4	r25c5	r25c6	r25c7	r25c8
Row 2	r26c3	r26c4	r26c5	r26c6	r26c7	r26c8
Row 3	r27c3	r27c4	r27c5	r27c6	r27c7	r27c8
Row 4	r28c3	r28c4	r28c5	r28c6	r28c7	r28c8
Row 5	r29c3	r29c4	r29c5	r29c6	r29c7	r29c8
Row 6	r30c3	r30c4	r30c5	r30c6	r30c7	r30c8
Row 7	r31c3	r31c4	r31c5	r31c6	r31c7	r31c8
Row 8	r32c3	r32c4	r32c5	r32c6	r32c7	r32c8
Row 9	r33c3	r33c4	r33c5	r33c6	r33c7	r33c8
Row 10	r34c3	r34c4	r34c5	r34c6	r34c7	r34c8
Row 11	r35c3	r35c4	r35c5	r35c6	r35c7	r35c8
Row 12	r36c3	r36c4	r36c5	r36c6	r36c7	r36c8
Row 13	r37c3	r37c4	r37c5	r37c6	r37c7	r37c8
Row 14	r38c3	r38c4	r38c5	r38c6	r38c7	r38c8
Row 15	r39c3	r39c4	r39c5	r39c6	r39c7	r39c8



Mail Merge
See Excel Worksheet: Mail Merge
Mail merge is defined as: the automatic addition of names and addresses from a database to letters and envelopes in order to facilitate sending mail, especially advertising, to many addresses.
The add-in was not designed for high-volume automated mail merge and it should not be used as a replacement for Word’s native “Mailings” (Mail Merge) features.
The add-in can effectively be used to lookup recipient data from a list/table, calculate results, then update Word/PowerPoint templates. This enables rapid creation of personalized data-intensive documentation. However, unlike Mail Merge, the documents must be updated one at a time. 
The example below looks up company data from an Excel table based on a drop-down list, calculates results, then updates text, a table, and a chart in Word/PowerPoint. This process would have to be repeated for each recipient.
	Based on our analysis, we believe Berkshire Hathaway could save $351 billion by purchasing our solution. Act today and you can purchase it for only $75 billion.

	Per Employee	Company Total (Billions)
Our Savings	 $930 	 $350.6 
Competitor Savings	 $300 	 $113.1 
Solution Cost	 $200 	 $75.4 


	


[bookmark: _Currency_Switching][bookmark: _Toc531342351]

[bookmark: _Localization_(Currency_and][bookmark: _Toc123730846]Localization (Currency and Language)
It is often important to be able to easily localize (currency and language) assessment tools and results documents. For example:
· supporting users who are located in different regions
· creating documents for customers located in other countries
Currency Switching (currency symbols and exchange rates)
See Excel Worksheet: Currency
This example shows how to change currency symbols and exchange rates (via a drop-down selection) in your Excel and destination documents.
	Your net benefit is expected to be 211.67 €.

	One Time	Annual Recurring	Project Total
Total Investment	94.07 €	18.81 €	188.15 €
Total Benefits	47.04 €	70.56 €	399.81 €
Net Benefit			211.67 €


	



[bookmark: _Language_Switching][bookmark: _Toc531342352]Language Switching
See Excel Worksheet: Language
The example below shows how to change language (via a drop-down selection) in your Excel and destination documents. It also changes currency.
Evaluación del valor empresarial de la solución
Basándonos en nuestro análisis, creemos que su empresa podría ahorrar 177.00 € millones comprando nuestra solución. Actuar hoy y se puede comprar por sólo 199.12 € Mil millones.
	

	Una vez	Recurrente anual	Total del proyecto
Inversión total	88.50 €	17.70 €	177.00 €
Total de beneficios	44.25 €	66.37 €	376.12 €
Beneficio neto			199.12 €


	



[bookmark: _Import_Data_-]Often organizations have a destination document template for each language and a single Excel workbook is used to update the dynamic content in the destination documents. 
This is often combined with the Excel table “Disable Cell Updates” feature. Table row/column header text is left unchanged in each document (which are in different languages) and only the cells with data are updated. This avoids the need to transfer the text (in each language) from Excel to the Word/PowerPoint tables. 
The “Cloud Reporting” in the Enterprise version is also very helpful with this scenario: the user selects the region (currency/language) in an Excel drop-down, completes their assessment, then simply selects the desired report template (there would be one for each language) from a drop-down in the add-in and they download the personalized report in the customer’s preferred language/currency.
[bookmark: _Layout_Options_1][bookmark: _Toc123730847]Layout Options
Dynamic content can be incorporated in a variety of ways (not just in-line) enabling great-looking documents/presentations.
WordMerchant
Date
Category
Amount
The Phone Company
5/18/2025
Communications
$120.00
Best For You Organics Company
5/16/2025
Groceries
$27.00
Coho Vineyard
5/15/2025
Restaurant
$33.00
Bellows College
5/14/2025
Education
$350.00
Best For You Organics Company
5/12/2025
Groceries
$97.00


The content controls can be placed in-line with text (the default) or you can insert the controls within containers, such as text boxes, and these containers can be placed anywhere (not just in-line with text). This enables very powerful/flexible layout options, such as updatable dashboards, infographics, and great-looking personalized branded marketing/sales material.
In the example to the right, a table is placed inside a text box and the text box wrapping style is set to square.
PowerPoint
All PowerPoint content is shape-based. Shapes can be titles, text boxes, tables, images, etc. Shapes are tagged (with the link code in the shape’s alt-text property) and updated by the add-in. Shapes can be placed anywhere on a slide (including overlapping). A slide can contain many shapes. Slides and shapes can be copied/pasted and will retain their links.
[bookmark: _Toc531342353]Headers, Footers, and Master Slides
In Word, linked text can be placed in headers and footers.
In PowerPoint, master slides can contain linked content.
[bookmark: _Mail_Merge]

[bookmark: _Import_Data_-_1][bookmark: _Toc123730848]Import Data - Importing external data into Excel
Users commonly import data from external sources into Excel, so it can then be consolidated/analyzed in Excel and then updated in Word and PowerPoint documents. Common data sources include: web site data; databases; Azure; CRM/ERP systems, such as Salesforce; other Excel workbooks, web services, XML/JSON data, etc. 
Here are a few Microsoft resources that may be helpful:
· Import data from external data sources (Use Excel's Get & Transform (Power Query) experience to import data into Excel from a wide variety of data sources. You can then use the Query Editor to edit query steps to shape or transform data.)
· Get & Transform in Excel Get & Transform enables you to connect, combine, and refine data sources to meet your analysis needs.
· Overview of connecting to (importing) data This reference article discusses importing and connecting data. You will learn about tasks like importing, updating, securing, and managing data.
Most major software/app vendors provide ways for users to securely import data into Excel. There are also many 3rd-party solutions, including other add-ins, to help connect Excel to apps and other data sources. Microsoft’s Power BI is also commonly used to import and analyze enterprise data.
The Enterprise version also contains a “Data Refresh” feature that can automatically update frequently updated data (such as pricing and exchange rate data) every time the workbook is opened.
[image: ]
Line Chart

Region A	2022	2023	2024	2025	100	80	64	51.2	Region B	2022	2023	2024	2025	50	60	72	86.4	Region C	2022	2023	2024	2025	150	165	181.5	199.65	



Column Chart

Series A	Category 1	Category 2	Category 3	Category 4	50	35	24.5	17.149999999999999	Series B	Category 1	Category 2	Category 3	Category 4	25	10	12.25	8.5749999999999993	Series C	Category 1	Category 2	Category 3	Category 4	75	52.5	36.75	25.725000000000001	



Combo - Clustered Column - Line

Series A	Category 1	Category 2	Category 3	Category 4	50	35	24.5	17.149999999999999	Series B	Category 1	Category 2	Category 3	Category 4	25	10	12.25	8.5749999999999993	Series C	Category 1	Category 2	Category 3	Category 4	75	52.5	36.75	25.725000000000001	



Area Chart

Series A	Category 1	Category 2	Category 3	Category 4	50	35	24.5	17.149999999999999	Series B	Category 1	Category 2	Category 3	Category 4	25	10	12.25	8.5749999999999993	Series C	Category 1	Category 2	Category 3	Category 4	75	52.5	36.75	25.725000000000001	



Combo - Stacked Area – Clustered Column

Series A	Category 1	Category 2	Category 3	Category 4	50	35	24.5	17.149999999999999	Series B	Category 1	Category 2	Category 3	Category 4	25	10	12.25	8.5749999999999993	Series C	Category 1	Category 2	Category 3	Category 4	75	52.5	36.75	25.725000000000001	



Line Chart

Series A	45792.9826159722	45793.9826159722	45794.9826159722	45795.9826159722	50	55	60.5	66.55	Series B	45792.9826159722	45793.9826159722	45794.9826159722	45795.9826159722	25	37.5	56.25	84.375	Series C	45792.9826159722	45793.9826159722	45794.9826159722	45795.9826159722	65	52	41.6	33.28	



Pie

Slice Size	
Category 1	Category 2	Category 3	Category 4	50	35	24.5	17.149999999999999	


Slice Size	
Category 1	Category 2	Category 3	Category 4	50	35	24.5	17.149999999999999	

Scatter

Y-Values	50	45	40.5	36.450000000000003	32.805	29.5245	26.572050000000001	23.914845	21.523360499999999	19.37102445	17.433922004999999	15.690529804500001	14.121476824049999	12.709329141645	11.438396227480499	25	27.5	30.25	33.274999999999999	36.602499999999999	40.262749999999997	44.289025000000002	48.717927500000002	53.589720249999999	58.948692275000099	64.843561502500094	71.327917652750102	78.460709418025104	86.306780359827599	94.937458395810395	


Scatter - 2 Series

Y1-Values	50	45	40.5	36.450000000000003	32.805	100	110	121	133.1	146.41	Y2-Values	50	45	40.5	36.450000000000003	32.805	37.5	33.75	30.375	27.337499999999999	24.603750000000002	


Stock Chart

Volume	45795.9826159722	45796.9826159722	45797.9826159722	45798.9826159722	45799.9826159722	50	45	40.5	36.450000000000003	32.805	Open	45795.9826159722	45796.9826159722	45797.9826159722	45798.9826159722	45799.9826159722	10	13	16	19	22	High	45795.9826159722	45796.9826159722	45797.9826159722	45798.9826159722	45799.9826159722	16.899999999999999	20.8	24.7	28.6	32.5	Low	45795.9826159722	45796.9826159722	45797.9826159722	45798.9826159722	45799.9826159722	8	10.4	12.8	15.2	17.600000000000001	Close	45795.9826159722	45796.9826159722	45797.9826159722	45798.9826159722	45799.9826159722	13	16	19	22	25	
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2023 2024 2025 Grand Total
Accessories $67,800 $67,800
Bikes $6,300 $6,300
Clothing  $23,700 $2,300 $40,000  $66,000
Components _ $2,300 $4,100 $25,700  $32,100
Grand Total $26,000 $80,500 $65,700 $172,200
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  AnalysisPlace Sample Content  --   Sunday May 18, 2025 11:34 PM         AnalysisPlace    Excel - to - Word  Document Automation   Add - In   Update/create Word and PowerPoint content (text, tables, and charts) based on Excel data and calculations.         Sample Content  and How - To Guide     This  d ocument  demonstrates  key  capabilities   of t he ad d - in .  U se   it   with  AnalysisPlace_Sample_Content_and_How - To_Guide.xlsx   Also see   the   Example Financial Tables       To use this document:       In  Excel :      Add   the add - in (Excel Ribbon Menu: Insert > Get Add - ins) , then activate it  (right side of Home ribbon)      “Insert Sample Content” on the Start tab of the add - in      Make changes to any of the tan input cells in the workbook. Start with the QuickStart worksheet       “Submit Content” in the Excel add - in   Here In  Word :      If the add - in is not visible,  add/ activate it      “Update Document”, in the add - in in this document. You should be able to see the changes  starting on the next  page   based on your Excel modifications     If you are not already familiar with the basic features of the add - in, first see   A nalysis P lace.com     This document has  “ Auto - Open ”   enabled , meaning the add - in should  automatically  open with the document. Normally  Auto - Open  can   only  be  e nabled   with   Excel  workbooks .      

